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01. SOFTWARE INSTALLIEREN UND DEINSTALLIEREN 01. SOFTWARE INSTALLIEREN UND DEINSTALLIEREN

GRUNDLEGENDE INSTALLATIONSSCHRITTE SOFTWARE KONFIGURATION

SOFTWARE KONFIGURATION

01 • Installieren Sie die Access Control Software.

02 • Klicken Sie auf "Next".

03 • Klicken Sie auf "Next".

04 • Klicken Sie auf "Next".

01 • Legen Sie zuerst die CD in das CD-ROM-Laufwerk, starten Sie dann die Anwendung "setup.exe" oder 
über unsere Website, indem Sie den Software-Ordner herunterladen und die Anwendung "setup.exe" 
ausführen, die sich im innerem der Software befindet.

Speicher: 1 GB.
Festplatte: 1 GB  über freiem Speicherplatz.

• Windows 7
• Windows 10

GRUNDLEGENDE INSTALLATIONSANFORDERUNGEN

SYSTEMBETRIEB, DER VON DER SOFTWARE UNTERSTÜTZT WIRD
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05 •  Klicken Sie auf "Close".
Nach Abschluss der Installation wird diese automatisch                  erstellt und auf Ihrem Computerbildschirm 
angezeigt.  

01. SOFTWARE INSTALLIEREN UND DEINSTALLIEREN 01. SOFTWARE INSTALLIEREN UND DEINSTALLIEREN

SOFTWARE KONFIGURATION

SOFTWARE LÖSCHEN

SOFTWARE LÖSCHEN
01 • Klicken Sie auf "Start" und geben Sie "Control Panel" ein.
02• Klicken Sie auf "Uninstall a program".

03 • Suchen Sie die Software "Access Control" und klicken Sie auf "Uninstall".

04 • Klicken Sie auf "Yes".
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

ANMELDEN ANMELDEN
Klicken Sie                  auf Start> Programme> Zugriffskontrolle> Zugriffskontrolle, um das Anmeldefenster 

wie folgt zu öffnen:

Benutzer: abc
Passwort: 123
Es wird empfohlen, Ihren Benutzernamen und Ihr Passwort nach der ersten Verwendung zu ändern.

Wenn die SQL Server Verbindung fehlschlägt. Wird das  Dialogfeld angezeigt.
01 • Klicken Sie auf "OK". Weitere Informationen finden Sie in Anhang SQL Server Konfiguration.
Nach der Anmeldung wird das Hauptfenster wie folgt angezeigt:

GERÄTE PARAMETER EINSTELLUNGEN
CONTROLLER HINZUFÜGEN / KONFIGURIEREN
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

GERÄTE PARAMETER EINSTELLUNGEN GERÄTE PARAMETER EINSTELLUNGEN
01 • Klicken Sie in der Menüleiste auf Configuration > Controllers.
02 • Klicken Sie auf die Schaltfläche "New", um die Treiber zum System hinzuzufügen.

Die Controller Nummer (dies ist die Seriennummer des Controllers) finden Sie auf dem S/N Etikett: 
********* des Controllers. Bitte geben Sie die neun Zahlen ein.

"Door Name” und “Reader Position” können geändert werden.
04 • Aktivieren Sie "Active", , die Konsole zeigt den Port an, andernfalls wird er nicht angezeigt.
05 • Aktivieren Sie "Attendance", damit die Kartenleseraufzeichnungen als Anwesenheitsaufzeichnungen 
verwendet werden können, andernfalls werden sie nicht verwendet.
06 • Klicken Sie auf "Ok".

03 • Klicken Sie auf "Next".

Wenn der von Ihnen geschriebene S/N Controller nicht mit dem S/N Tag übereinstimmt: 
********* kann die Software nicht mit dem Controller kommunizieren.

Kleines Netzwerk: Unterstützt die TCP/IP Kommunikation, alle Controller befinden sich im 
selben Netzwerksegment.

Mittleres oder großes Netzwerk oder Internet: Unterstützt die TCP/IP Kommunikation zu 
verschiedenen Netzwerksegment-Controllern.
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

GERÄTE PARAMETER EINSTELLUNGEN GERÄTE PARAMETER EINSTELLUNGEN

HINZUFÜGEN / IP-KONFIGURATION

01 • Klicken Sie auf "Search".

03 • Klicken Sie auf "OK".

Ergebnis, können Sie die IP Adresse sehen.
04 • CKlicken Sie auf "Next".

Die Controller sind in verschiedene Netzwerke unterteilt. Jedem Controller muss eine eindeutige IP 
Adresse zugewiesen werden.

Die Suche dauert ca. 5 Sekunden.
02 • Klicken Sie auf "Configure".

Nach dem Konfigurieren der IP Adresse können Sie die Controller Parameter einstellen, die IP Adresse 
muss dem entsprechenden Controller zugewiesen werden.
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

GERÄTE PARAMETER EINSTELLUNGEN GERÄTE PARAMETER EINSTELLUNGEN

IP-FILTER TREIBERZONE VERWALTEN

Aus Sicherheitsgründen hat nur ein Computer Zugriff auf diese Software und diese Datenbank. Klicken 
Sie mit der rechten Maustaste und wählen Sie "IP Filter".

02 • Klicken Sie auf "Add Top" und schreiben Sie in den leeren Bereich.

03 • Klicken Sie auf "OK".
Als Ergebnis können Sie die erstellte Zone sehen.

Geben Sie die zulässige IP ein und klicken Sie auf "Add Allowed IP" oder klicken Sie auf "Add Current PC IP".
01 • Klicken Sie auf "Only Update IP List"

01 •  Klicken Sie mit der linken Maustaste auf den Controller und dann auf "Zones".
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

GERÄTE PARAMETER EINSTELLUNGEN ABTEILUNGSBETRIEB UND REGISTRIERTER BENUTZER

04 • Klicken Sie auf "Add Branch", um einen neuen Standort unter der Zone hinzuzufügen.
05 • Schreiben Sie in den leeren Bereich und klicken Sie auf "OK".
Ergebnis: Sie können den von Ihnen erstellten Speicherort sehen.

Schließe dieses Fenster.
05 • Stellen Sie das Zone auf dem Controller ein.

01 • Klicken Sie in der Menüleiste auf Configuration>  Department.
02 • Klicken Sie auf die Schaltfläche "Add Top", um eine Abteilung hinzuzufügen.
03 • Schreiben Sie in das leere Feld und klicken Sie auf "Ok".

ABTEILUNG HINZUFÜGEN
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

ABTEILUNGSBETRIEB UND REGISTRIERTER BENUTZER ABTEILUNGSBETRIEB UND REGISTRIERTER BENUTZER
04 • Klicken Sie auf "Add Branch", um eine neue Unterteilung unter der Abteilung hinzuzufügen.
05 • Schreiben Sie in das leere Feld und klicken Sie auf "Ok".
Ergebnis: Sie können den von Ihnen erstellten Speicherort sehen.

BENUTZER HINZUFÜGEN UND BEARBEITEN

01 • Klicken Sie in der Menüleiste auf Configuration> Personnel.
02 • Klicken Sie auf die Schaltfläche "Add", um Benutzer hinzuzufügen.

03 • Geben Sie in das Feld "User ID" und "Name" ein.
04 • Um dem Benutzer ein Foto hinzuzufügen, klicken Sie auf "Photo" und wählen Sie die gewünschte Datei aus.
05 • Nachdem Sie die Informationen in diese Benutzerfelder eingegeben haben, klicken Sie auf "Add Next", damit das 
Präsentationsfenster weiterhin geöffnet ist und Sie Informationen von einem anderen Benutzer eingeben können.
Wenn Sie keine weiteren Benutzer hinzufügen möchten, klicken Sie auf "OK" und der Benutzer wurde dem System 
hinzugefügt.
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

ABTEILUNGSBETRIEB UND REGISTRIERTER BENUTZER ABTEILUNGSBETRIEB UND REGISTRIERTER BENUTZER
06 • Um den erstellten Benutzer zu bearbeiten, klicken Sie auf "Edit".
Sie können weitere Informationen über das Untermenü "Others" hinzufügen.

Ergebnis, Sie sehen die Registrierungskarten.
04 • Klicken Sie am Ende des Vorgangs auf "OK". Die Registrierungskarten werden dem System hinzugefügt.

AUTOMATISCH REGISTRIERUNGSKARTE HINZUFÜGEN

01 • Klicken Sie in der Menüleiste auf Configuration> Personnel> Auto Add.
02 • Wenn Sie "USBReader" auswählen, verbinden Sie den USB Kartenleser (Modell # für das Wiegand 
Produkt ist WG1028) mit dem Computer.
03 • Klicken Sie auf "USB Reader" oder "Controller" und dann auf "Next".
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

ABTEILUNGSBETRIEB UND REGISTRIERTER BENUTZER ABTEILUNGSBETRIEB UND REGISTRIERTER BENUTZER
05 • Wenn Sie "Manual Batch Input" auswählen, werden die Registrierungskarten manuell hinzugefügt.
06 • Klicken Sie auf "Manual Batch Input" und dann auf "Next".
07 • Schreiben Sie in die Felder "Start No." und "End No."
08 •  Klicken Sie am Ende des Vorgangs auf "Ok". Die Registrierungskarten werden dem System hinzugefügt.
Ergebnis, Sie sehen die Registrierungskarten. Alle Karten werden automatisch registriert. Der 
Standardname lautet "N + Kartennummer".

VERLUST DER KARTE • ZUGRIFF AUF PRIVILEGIEN

Wenn jemand Ihre Karte verliert, müssen Sie die verlorene Karte registrieren und anschließend eine 
neue Karte an den Benutzer geben.
01 • Klicken Sie in der Menüleiste auf  Configuration> Personnel> Card Lost.

01 • Klicken Sie in der Menüleiste auf Configuration> Access Privilege.
02 • Klicken Sie auf "Change Privileges".

02 • Geben Sie im Feld "New Card NO" die neue Kartennummer ein und klicken Sie auf "Ok".
Wenn die Benutzerkarte über Berechtigungen verfügt, aktualisieren Sie den Controller, nachdem Sie den 
Kartenverlust gemeldet haben.

OPERATION
PRIVILEGE MANAGEMENT
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

OPERATION OPERATION

03 • ">>" Wählen Sie alle Benutzer oder alle optionalen Ports aus.
">" Wählen Sie einen Benutzer oder einen optionalen Port aus.
"<" Einen ausgewählten Benutzer oder einen ausgewählten Port abbrechen.
"<<" Alle ausgewählten Benutzer oder alle ausgewählten Ports abbrechen.

04 • Durch Klicken auf "Allow" und dann auf Vorgang> Upload  können ausgewählte Benutzer die 
ausgewählten Ports durchlaufen.
Durch Klicken auf "Allow and Upload" können ausgewählte Benutzer die ausgewählten Ports durchlaufen.
Wenn Sie auf "Prohibit" und dann auf Operation> Upload  klicken, können die ausgewählten Benutzer die 
ausgewählten Ports nicht durchlaufen.
Wenn Sie auf "Prohibit and Upload" klicken, können ausgewählte Benutzer die ausgewählten Ports nicht 
durchlaufen.

05 • Klicken Sie nach Hinzufügen aller Berechtigungen zum System, auf Operation> Upload, um den 
Controller zu aktualisieren. 

03 • Klicken Sie auf "Confirm and Upload", wenn Sie optionale Ports hinzugefügt oder ausgewählte Ports 
abgebrochen haben, um die Steuerung zu aktualisieren, und der Benutzer kann die ausgewählten Ports 
durchgehen.

• BENUTZER PRIVILEGE BEARBEITEN 

01 • Wählen Sie den Benutzer aus und klicken Sie auf "Edit One User".
02 • ">>" Wählen Sie alle optionalen Ports aus.

">" Wählen Sie einen optionalen Port.
"<" Einen ausgewählten Port abbrechen.
"<<" Alle ausgewählten Ports abbrechen.
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

KONSOLE KONSOLE
01 • Klicken Sie in der Menüleiste auf Operation> Console.

CONTROLLER INFORMATION
01 •  Klicken Sie in der Menüleiste auf Operation> Console> Check.
Ergebnis, Zeigt die grundlegenden Informationen des Controllers an, z. B. die Anzahl der Kartendurchläufe 
und Berechtigungen, den Portstatus, den Controller Status und vieles mehr. Wenn der Controller gut mit 
dem Computer kommuniziert, ist die Anschlussfarbe grün, andernfalls ist sie rot.

KONFIGURIEREN HOCHLADEN

01 • Klicken Sie in der Menüleiste auf Operation> Console> Upload.
02 • Klicken Sie auf "OK".
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02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

KONSOLE KONSOLE

MONITOR REGISTER ERHALTEN

REGISTER KONSULTIEREN

01 • Klicken Sie in der Menüleiste auf Operation> Console> Download And Monitor. 01 • Klicken Sie in der Menüleiste auf Operation> Console> Download. Sammelt die Treiberdatensätze 
für die Datenbank.

Führen Sie zuerst ein "Download" der Datensätze vor der Abfrage.
01 • Klicken Sie in der Menüleiste auf Operation> Query Swipe Records. 

01 • Klicken Sie mit der rechten Maustaste und wählen Sie "Display More Swipes". Es werden nur 
Kartenkarten angezeigt.

MEHR REGISTER ANZEIGEN



16A 16B
DEDE

Wenn Sie die Ein und Ausgänge nach "Addr" filtern möchten, klicken Sie auf "Query Option."
02 • Klicken Sie auf "Query", um die gewünschten Datensätze anzuzeigen.

Sie können den Namen und das Passwort des Betreibers ändern.
01 • Klicken Sie in der Menüleiste auf Tools>  Edit Operator.

01 • Klicken Sie in der Menüleiste auf File> DB Backup.
02 • Klicken Sie auf "Ok".
Diese Sicherung wird über den Pfad "C:\AccessControl" auf das System geschrieben.
Wenn die Sicheheits Kopie ist SQL DB. Die Sicherung wird unter dem Pfad "C:\Programme\Microsoft SQL
Server\MSSQL10.MSSQLSERVER\MSSQL\Backup" auf das System gespeichert.

02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

KONSOLE EIGENSCHAFTEN

EIGENSCHAFTEN
PASSWORT ÄNDERN

DATENBANK BACKUP

02 • Schreiben Sie in das leere Feld und klicken Sie auf "OK".
HINWEIS: "New Password" und "Confirm Password" müssen identisch sein. Starten Sie nach dem Ändern 
des aktuellen Kennworts das System neu und melden Sie sich erneut an.
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OPTION

02. SOFTWARE GRUNDLEGENDE BEDIENUNG 02. SOFTWARE GRUNDLEGENDE BEDIENUNG

03. ERWEITERTE FUNKTIONEN

EIGENSCHAFTEN

Sie können andere Systemeinstellungen ändern.
01 • Klicken Sie in der Menüleiste auf Tools > Language, um die Sprache zu ändern.

Wenn Sie die erweiterten Funktionen aktivieren, müssen Sie das System neu starten.

02 • Klicken Sie in der Untermenüleiste auf "Interface Setting", um die Schnittstelle zu ändern.
House: Wird im Community Management verwendet.
Show Getting Started When Login: Anleitung für die Betriebssoftware.

03 • Klicken Sie in der Untermenüleiste auf" "Auto Login" ", um die Funktion zu aktivieren.
Sie müssen nicht mehr "User Name" und "Password" eingeben, um sich im System anzumelden.

EIGENSCHAFTEN

01 • Klicken Sie in der Menüleiste auf Tools > Extended Functions.
Geben Sie das Passwort ein.
Passwort: 5678
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
DATEI KONFIGURATION

01 • Aktivieren Sie "Active Log Query", um die Protokollabfrage zu aktivieren.

AKTIVIEREN DES REGISTER KONSULTIEREN DRUCKTASTEN EREIGNISSE AUFNEHMEN

Zeichnet jedes Mal auf, wenn die Taste gedrückt wird.
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
KONFIGURATION KONFIGURATION

Sie müssen den Türsensor anschließen. Zeichnet die Zeit von "Door Open" und "Door Closed" auf.
HINWEIS: Nach dem Aktivieren einer Funktion müssen Sie die Konsole "Upload".

AKTIVIEREN ZEITPROFIL

01 • Aktivieren Sie die Optionen "Activate Time Profile" und  "Activate Time Seg Limitted Access".
02 • Klicken Sie in der Menüleiste auf Configuration > Time Profile.

03 • Klicken Sie auf "New", um ein neues Zeitprofil und seine Eigenschaften hinzuzufügen.
04 • Schreiben Sie in die leeren Felder und klicken Sie auf "Ok".

Ergebnis, Sie können durch Hinzufügen einer "Normalen" Benutzerkarte das erstellte Profil bearbeiten 
und sich innerhalb der festgelegten Zeit an und abmelden.
Wählen Sie nach dem Definieren der verschiedenen gewünschten Zeitprofile die Berechtigungen aus, 
die den Benutzern im Berechtigungszugriff entsprechen.

TÜRSTATUS EREIGNISSE AUFZEICHNEN
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
KONFIGURATION KONFIGURATION

AKTIVIEREN PERIPHERISCHE KONTROLLE

01 • Aktivieren Sie die Option "Activate Peripheral Control", "Threate Code Valid After RegisgterCard 
Swipe" und Activate Open Too Long Wam".

02 • Klicken Sie in der Menüleiste auf Configuration > Peripheral.

03 • "Threat Code" : sollte mit dem PIN Tastaturkartenleser verwendet werden.
04 • Klicken Sie auf "Hardware Configuration".

05 • Bestimmen Sie die gewünschten Einstellungen.
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
KONFIGURATION KONFIGURATION

AKTIVIEREN TASTATURZUGRIFF
01 • Aktivieren Sie die Option "Activate Access Keypad".

02 • Klicken Sie in der Menüleiste auf Configuration > Pwd MGT.

03 • Bestimmen Sie die gewünschten Einstellungen.
04 • Klicken Sie auf "Card+PIN", oder "PIN Code" oder "Controller's Password" oder "Manual Input 
Password", je nach Ihren Einstellungen.

HINWEIS: Im Untermenü "PIN Code" lautet das Standardkennwort des Benutzers 345978.
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
KONFIGURATION KONFIGURATION

AKTIVIEREN ANTI PASS BACK

AKTIVIEREN INTERNE SPERRE

01 •  Aktivieren Sie die Option "Activate Anti Pass Back".

01 • Aktivieren Sie die Option "Activate Anti Inter Lock".
HINWEIS: Diese Funktion steht nur beim MCA-02 mit zwei Anschlüssen zur Verfügung. 

02 • Klicken Sie in der Menüleiste auf Configuration > Anti-passback.

03 • Bestimmen Sie die gewünschten Einstellungen.
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
KONFIGURATION KONFIGURATION
02 • Klicken Sie in der Menüleiste auf Configuration > Inter Lock.

03 • Bestimmen Sie die gewünschten Einstellungen.

03 • Bestimmen Sie die gewünschten Einstellungen. Jede Gruppe mit zwei oder mehr Benutzern kann das 
Tor öffnen, indem sie ihre Karten gemeinsam austeilt.

AKTIVIEREN ZUGRIFF VERSCHIEDENE KARTEN
01 • Aktivieren Sie die Option "Activate MultiCard Access".
02 • Klicken Sie in der Menüleiste auf Configuration > Multi-card.
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
KONFIGURATION KONFIGURATION

AKTIVIEREN ERSTE ÖFFNUNGSKARTE
01 • Aktivieren Sie die Option "Activate First Card Open".

04 • Aktivieren Sie die Option "Aktive" und legen Sie die gewünschten Einstellungen fest.

02 • Klicken Sie in der Menüleiste auf Configuration > First Card.

03 • Wählen Sie den Benutzer aus und klicken Sie auf "Edit".
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
KONFIGURATION KONFIGURATION

AKTIVIEREN DER AUFGABENLISTE DES CONTROLLERS
01 • Aktivieren Sie die Option "Activate First Controller TaskList".

02 • Klicken Sie in der Menüleiste auf Configuration > Task List.

03 • Sie können Aufgaben hinzufügen, auf "Add" klicken oder Aufgaben bearbeiten, auf "Edit" klicken.

04 • Bestimmen Sie die gewünschten Einstellungen.



26A 26B
DEDE

03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
OPERATION MULTIFUNKTIONEN

AKTIVIEREN DES TOR ÖFFNEN AUS DER FERNE AKTIVIEREN ESSEN
01 • Aktivieren Sie die Option "Remote Open Door". 01 • Aktivieren Sie die Option "Activate Meal".

01 • Klicken Sie in der Menüleiste auf "Const Meal".

02 • Klicken Sie in der Menüleiste auf Operation> Console.
03 • Wählen Sie zuerst den gewünschten Port aus und klicken Sie dann auf "Remote Open".
Ergebnis: Die ausgewählte Tür wird geöffnet.

• ESSEN KONFIGURIEREN

• • LESER
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02 • Klicken Sie auf "Meal Setup" und wählen Sie das "Readers".
03 • Bestimmen Sie die gewünschten Einstellungen.

01 • Klicken Sie auf "Meal Setup" und wählen Sie das Untermenü "Rules".
02 • Bestimmen Sie die gewünschten Einstellungen.

01 • Klicken Sie auf "Meal Setup" und wählen Sie das Untermenü "Meal Period".
02 • Bestimmen Sie die gewünschten Einstellungen.

03 • Sie können auch die Verbrauchsmenge einstellen, auf "Option" klicken und die gewünschten 
Einstellungen vornehmen.

03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN

• • REGELN

• • ESSEN ZEITRAUM
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• ESSEN BERICHT

• • ESSEN DETAILS BERICHT

• • LESE STATUS BERICHT • • BENUTZER STATUS BERICHT

• • TEILGESAMTBERICHT DER ABTEILUNG

01 • Klicken Sie auf "Create" und alle Details des Benutzers werden angezeigt.

01 • Klicken Sie auf "Create" und wählen Sie "Subtotal of Readers" aus dem Untermenü. Alle Essenszeiten 
und das Geld werden nach Zonen sortiert.

01 • Klicken Sie auf "Create" und wählen Sie "Statistics" aus dem Untermenü. Die Zeit und die 
Gesamtausgaben der einzelnen Benutzer werden statistisch geordnet.

01 • Klicken Sie auf "Create" und wählen Sie "Subtotal of Department" aus dem Untermenü. Alle 
Essenszeiten und das Geld werden nach Abteilung sortiert.

03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN

PATROL AKTIVIEREN
01 • Aktivieren Sie die Option "Activate Patrol".

02 • Klicken Sie in der Menüleiste auf "Patrol".

• PATROL KONFIGURIEREN

• • PATROL PUNKT

• • PATROL REGELN

01 • Klicken Sie auf "Patrol Setup".

02 • Stellen Sie den Port auf "Patrol Point".

01 • Klicken Sie auf "Patrol Point", wählen Sie "Patrol Rules" aus dem Untermenü und stellen Sie die 
aktuellen Regeln ein.
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03.FUNCIONALIDADES EXTENSAS03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN

• • PATROL MANN

01 • Klicken Sie auf "Patrol Point", wählen Sie "Patrolman" aus dem Untermenü und stellen Sie den 
Benutzer ein, der der Patrouillenmann ist.

01 • Klicken Sie auf "Route".

02 • Klicken Sie auf "New", um eine Patrouillenroute hinzuzufügen.

03 • Bestimmen Sie die gewünschten Einstellungen.

• PATROL ROUTE
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN

01 • CKlicken Sie auf "Task" und legen Sie den Benutzer fest, der die Patrouillenroute erstellen soll. Stellen Sie sicher, dass Sie sich registrieren, bevor Sie den Bericht erstellen.
01 • Klicken Sie auf "Create".

02 • Klicken Sie auf "Arange" und dann auf "OK".

02 • Klicken Sie auf "Query Option" und stellen Sie den gewünschten Filter ein.
03 • Klicken Sie auf "Query".

• PATROL AUFGABE • PATROL BERICHT
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN

01 • Klicken Sie auf "Statistics".
Als Ergebnis erscheint die Patrouillenstatistik.

01 • Klicken Sie auf "Address Setup".

01 • Aktivieren Sie die Option "Activate Meeting".

• PATROL STATISTIKEN • ADRESSE KONFIGURIEREN

VERSAMMLUNG AKTIVIEREN
02 • Klicken Sie auf "Add", um die Besprechungsadresse festzulegen.
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03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN
03 • Geben Sie den Namen der Besprechung in das Feld "Meeting Address" ein, legen Sie den Port fest 
und klicken Sie dann auf "OK".

01 • Klicken Sie auf "Add".

01 • Klicken Sie auf "Stat". Die detaillierte Statistik des gewünschten Meetings wird angezeigt. Sie können 
nach "Should", "In fact", "Leave", "Absent", "Late", "Total statistical" e "Calculate participants rate" filtern.

02 • Fügen Sie das Meeting als wöchentliches Meeting, "Weekly Meeting" oder eine beliebige andere Einstellung 
hinzu.
03 • Identifizieren Sie Benutzer als "Delegate", "Nonvoting Delegate", "Invitationa", "Audit", "Employee" und 

"Other".
04 • Wenn Sie das Meeting ändern möchten, klicken Sie auf "Edit". Wenn Sie es löschen möchten, klicken Sie auf 

"Delete" in der Hauptoberfläche von "Meetings".

• VERSAMMLUNG HINZUFÜGEN

• SATUS DER VERSAMMLUNG



34A 34B
DEDE

03. ERWEITERTE FUNKTIONEN03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN MULTIFUNKTIONEN

01 • Klicken Sie auf "Realtime Sign". Es wird in Echtzeit angezeigt, was in der Besprechung vorhanden ist.

• ECHTZEIT EINTRAG • OPERATOR MANAGEMENT AKTIVIEREN

EIGENSCHAFTEN

01 • Aktivieren Sie die Option "Activate Operator Management".
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04. TEILNAHME03. ERWEITERTE FUNKTIONEN
MULTIFUNKTIONEN NORMALE JEWEILIGE BESTIMMUNGEN
02 • Klicken Sie auf "Tool" und dann auf "Operator Management".

02 •  Klicken Sie auf "Attendance" und dann auf "Normal Shift Rules".

03 • Verwenden Sie für den Benutzer "New", "Edit", "Del", "Edit Privilege", "Groups", und "Zones".
04 • Klicken Sie auf "Edit Privilege", um Benutzern eine ausführende Operation und eine Rollenberechtigung 
zuzuweisen.
HINWEIS: "abc" ist der standardmäßige Administrator für maximale Sicherheit. Sie können weder "Del" 
noch "Edit Privilege" verwenden.

01 • Auf dem System ist die Standardfunktion "Attendance" aktiviert. Wenn Sie diese Funktion abbrechen 
möchten, aktivieren Sie die Option "Don't Display Attendance".
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04. TEILNAHME04. TEILNAHME
FERIENNORMALE JEWEILIGE BESTIMMUNGEN

01 • Klicken Sie auf "Attendance" und dann auf "Holiday".

01 • Klicken Sie auf "Attendance" und dann auf "Leave Business Trip".
FERIEN

ARBEITSREISE

02 • Bestimmen Sie die gewünschten Einstellungen. 02 • Bestimmen Sie die gewünschten Einstellungen.
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02 • Bestimmen Sie die gewünschten Einstellungen.

04. TEILNAHME04. TEILNAHME
MANUELLE EINGABEARBEITSREISE

01 • Klicken Sie auf "Attendance" und dann auf "Manual Sign". 01 •  Klicken Sie auf "Attendance" und dann auf "Attendance Report".

MANUELLE EINGABE TEILNAHME BERICHT

02 • Bestimmen Sie die gewünschten Einstellungen.
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05. ANHANG04. TEILNAHME
SQL SERVER KONFIGURATIONTEILNAHME BERICHT

02 • Klicken Sie auf "Create" und dann auf "OK".

03 • Klicken Sie auf "Statistic".

01 • Installieren Sie SQL Server und konfigurieren Sie dann" "Access Control SQL Server" ".
02 • Klicken Sie auf Operation> Programs> AccessControl> SqlSet. 

03 • Klicken Sie auf "Test Conection" "und dann auf" "OK".
04 • Klicken Sie auf "Create Database" und dann auf "OK". Die aktuelle Datenbank wird gelöscht und eine 
neue erstellt.
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05. ANHANG05. ANHANG
EXCEL VERBRAUCHER INFORMATIONEN IMPORTIERENSQL SERVER KONFIGURATION

Sie sehen die Datenbank, die in der unteren Systemleiste als "SQL: AccessData" erstellt wurde.

HINWEIS: Sie können nur gültige Informationen unter "ConsumerNO", "Name", "CardID" und "Department" 
importieren.
01 • Klicken Sie auf  Configuration > Personnel > Export to Excel.
02 • Wählen Sie die Datei aus, in die die Informationen exportiert werden sollen, und klicken Sie dann auf Speichern.

05 • Klicken Sie auf  Configuration > Personnel > Import.
06 • Klicken Sie auf "Ok" und dann auf "Ok".

03 • Öffnen Sie die im Infofenster angegebene exportierte Excel Datei.

04 • Wenn das Dokument bereits Benutzerinformationen enthält, können Sie diese bei Bedarf löschen 
und neue  Benutzer erstellen. Erstellen Sie nur "ConsumerNO", "Name" -, "CardID" - und "Department" 
Informationen.
HINWEIS: Verwenden Sie in der Abteilung nur "\" als Trennzeichen. Zum Beispiel: Sales Dep\Oversea Marketing.

EXCEL VERBRAUCHER INFORMATIONEN IMPORTIEREN
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Ergebnis, die Datenbank wurde erstellt.

05. ANHANG
EXCEL VERBRAUCHER INFORMATIONEN IMPORTIEREN


